
 

Introducing MyFlix
MyFlix is a complete MPEG-1 video exploration tool.

With MyFlix you can

· play videos in real-time with sound,

· quickly and accurately get to any location in a video,

· play a presentation as a continuous loop or analyze the action of your favorite sports star using the 
Auto Repeat feature.

· cut and paste from separate videos to create your own custom video,

· find key video events, such as film cuts to create a shot index of your video.

This means that the entire video is at your fingertips – from extracting your favorite frames as snapshots 
to put in your photo album to combining those special moments in your existing videos into your own 
movie creation.

· Best of all MyFlix requires no special hardware to run on your computer.

If you require extended image analysis and more content based search tools have a look at the 
companion product WebFlix Pro.



How MyFlix Helps You Work With MPEG Videos

Have you ever tried to find a particular location in a video on your VCR, 35 MM film or even an MPEG file 
using standard searching techniques? Usually this involves watching the entire movie in fast forward or 
normal speed, then going back to painstakingly mark and edit the parts you want. 

· With MyFlix, the pain of this slow review and video searching is removed. MyFlix does the 
work for you by finding shots throughout the video and providing extended player controls to help you 
explore your video. Once calculated a shot index can be saved, edited and used as a movie summary
to quickly show others what’s in your video. 

· MyFlix can play your movie backwards as well as forwards, fast or normal speed and jump to any 
frame you like. You can even repeat play any section over and over to study a certain action 
sequence.

MyFlix supports MPEG editing, so that you can rearrange your footage from several movie files in to 
your own video masterpiece.



Limitations of the Demo Version

The demonstration version of MyFlix is identical to the full version you get when you register except 
for the following functions which are not present: 

· Generate movie: you cannot create a new movie,

· Save snapshot: you cannot save the current frame as a JPEG or TIFF snapshot,

· Save shot index: you can use the Shot Tool to find shots, but you cannot save a shot index.

Run this demonstration version as our guests for two weeks to find out whether MyFlix is for you or 
not. 

If you are considering buying MyFlix here are some important factors you should consider.

· If you agree with us that MyFlix provides a unique and powerful combination of MPEG player, 
exploration and editing tools, purchase a fully registered copy through the MediaWare Solutions web 
site at http://www.mediaware.com.au.



Thinking of Purchasing MyFlix?

When you purchase a registered copy of MyFlix you get the full benefits of being able to:-

· play videos in real-time with sound,

· quickly and accurately get to any location in a video,

· play a presentation as a continuous loop or analyze the action of your favorite sports star using the 
Auto Repeat feature.

· cut and paste from separate videos to create your own custom video,

· find key video events, such as film cuts to create a shot index of your video.

Concerned about buying technology that could rapidly become outdated? Don’t be:-

· We at MediaWare Solutions pride ourselves on the quality of our innovative technology and our Shot 
Detection algorithms represent the leading edge.

· MediaWare Solutions is constantly striving to make our products the best and most reliable that you 
can buy – so we release updates of our products at regular intervals.

· Our guarantee to you is that you are entitled to updates of MyFlix – for example if you buy 
version 1.4 of MyFlix    you can download the current version at any time and you can be sure of 
benefiting from running the latest and very best version of MyFlix all the way up to version 1.99.

So why wait? - purchase a fully registered copy of MyFlix through the MediaWare Solutions web site 
at http://www.mediaware.com.au



Recommended System Requirements
· Windows NT 4.0 or Windows 95

· Intel Pentium processor – 133MHz or faster

· 32MB memory

· 24 bit graphics (16, 24 and 32 bits are supported)

· Compatible sound card

· Microsoft ActiveMovie v1.0 or v2.0



Installation

Installation of MyFlix is performed by InstallShield™.

· If you accepted the defaults during installation, selecting Start->Programs->MediaWare Solutions-
>MyFlix from the Windows Start menu will show you the MyFlix Program Folder consisting of 

· MyFlix - the program, 

· ReadMe.txt - contains the release notes

· MyFlix.hlp - this Help guide.

· Take a few moments to review ReadMe.txt for any last minute changes and enhancements that didn’t 
find their way into this help guide.

To make the most of MyFlix we suggest a minimum recommended configuration for your computer system.



User Preferences

You can customize your copy of MyFlix by saving your preferences. This is done through the Options 
menu which allows you to choose and save for example:

· the folder where data files are saved by default

· whether the player rewinds automatically when it gets to the end of a video

· whether player repeat mode is on or not



Starting MyFlix
You start MyFlix through Windows Toolbar just like any other Windows program - simply click on 

Start->Programs->MediaWare Solutions->MyFlix->MyFlix

or you can double click on the MyFlix icon in Explorer or My Computer.    Note that if you over-rode the defaults 

during installation then your copy of MyFlix may appear in a different location in the Start menu.

The first time you start MyFlix you will be greeted with a Slide Show covering MyFlix’s major features.

 

After you have finished with the slides, you can start MyFlix.



Loading a Movie
To load a movie, click on the Load File option from the File menu. The file browser will enable you to 
select a disk drive and path and choose any file MPEG file to load. 

· Valid MPEG-1 files have a .mpg extension. 

· After loading the file the first frame will fill the display window and you can then play, analyze or edit 
your video.

· When loading large movies for the first time you may experience a short delay while MyFlix 
computes an index file.    The index file gives you the benefits of reliable and fast random access to 
any frame of the movie. Next time you load that movie that same index file is re-used.

· Index files have an .idx extension and use the same base name as the movie. For example if you 
load the movie MyMovie.mpg MyFlix will generate and save the file MyMovie.idx.



Detaching/Attaching the Display Panel
Detaching the Display Panel is useful when you are working with a large movie or you are using the 
Editor at the bottom of the MyFlix window. 

· click on File Menu->Detach to detach the Display Panel

· click on File Menu->Attach to re-attach the Display Panel







Playing a Movie
Playing a movie is done with the VCR-like controls in the Player Panel. You use the Player Controls to 
explore your movie interactively in normal, single-step, fast, backwards or forwards modes.

You can use the Shot Tool to help you get a handle on the contents of your movie and the Editor to 
rearrange your content into movie masterpieces.



Player Controls

MyFlix allows you to explore your video with an unprecedented degree of control and precision. In 
addition to the standard VCR-like controls functions you are already familiar with MyFlix equips you 
with additional controls that allow you to jump to any frame, play a selected region of a movie, play your 
video backwards or even loop over a section using Auto Repeat!

· Click on the individual controls of the screen shot to find out what each control does.

 

In this example, the Clip is focused on frames 483 to 856 of the movie and the Current Position is frame 
696 which would be seen in the Display Window (not shown here).



Auto Repeat: creates a loop out of the currently selected clip. If you are playing then when it gets to the end of the 
clip it will automatically rewind and start playing again from the start of the clip.      

In fact this looping behavior of Auto Repeat works with all playing modes – for example if you step back from the first
frame of the clip then you will find yourself at the end of the clip.

Auto Repeat is off when you start. To turn it on left click the Auto Repeat button once – it will light up. To turn it off left 
click again – the light will go off.



Play Backwards: plays the video (without sound) from the Current Positiontowards the Clip Start. The player plays
all the frames and so the play rate will depend on the speed of your computer.

You can pause the player by clicking on any of the player controls.



Play Forwards: plays the video (with sound) from the Current Position towards the Clip End. The player may drop 
frames in order to maintain real-time play. The faster your computer, the less frames will be dropped and the 
smoother the motion will appear.

You can pause the player by clicking on any of the player controls.



Current Position: this is the position of the Frame Cursor within the Clip. The Display Panel always displays the 
frame from the Current Position and Frame Counter shows the number of the frame at the Current Position.



Fast Backwards: skips quickly backwards through the movie from the Current Position towards the Clip Start. 

You can pause the player by clicking on any of the player controls. 

(Details: Fast Backwards works by only playing the I-frames, so the observed speed depend not only on the speed of 
your computer but also on the content of the movie and how it was originally encoded)



Fast Forwards: skips quickly forwards through the movie from the Current Position towards the Clip End.

You can pause the player by clicking on any of the player controls.

(Details: Fast Forwards works by only playing the I-frames, so the observed speed depend not only on the speed of 
your computer but also on the content of the movie and how it was originally encoded)



Step Forwards: steps forward one frame at a time through the movie from the Current Position towards the Clip 
End. Moves one frame each time you click the button.

(Details: all frames are played - I, B and P).



Step Backwards: steps backward one frame at a time through the movie from the Current Position towards the 
Clip Start. Moves one frame each time you click the button. 

(Details: all frames are played - I, B and P).



Pause: stops the movie at the current position. 

You can also pause the movie by clicking on any of the player buttons.



Go To Start: moves to the start of the Clip. 

(Details: after repositioning, the Frame Counter and Cursor are positioned at the Clip Start).



Go To End: moves to the end of the Clip. 

(Details: after repositioning, the Frame Counter and Cursor are positioned at the Clip End).



Clip Start: the first frame in the Clip. 



Clip End: the last frame in the Clip. 



Reset: selecting reset returns the interface to the same state as when the current movie was first loaded. 

(Details: after resetting, the Frame Counter and Cursor are positioned at the first frame in the movie, the Clip in the 
Focus Strip is set to the full movie).



Select Clip End: sets the Clip End to the Current Position. 

(Details:, loads the frame number in the Frame Counter into the Clip End). 



Select Clip Start: sets the Clip Start to the Current Position. 

(Details:, loads the frame number in the Frame Counter into the Clip Start). 



Frame Cursor: this is the yellow vertical marker in the Focus Strip which shows the Current Position within the Clip.
You can drag it with the left mouse button to any frame in the Clip.



Master Strip: represents the entire movie that is currently loaded. The orange section shows you where in the 
movie the currently selected Clip is coming from.



Focus Strip: holds the Clip currently being worked on. 

The Focus Strip allows you to select and work on a region of the full movie in greater detail. The Clip Start and Clip 
end are used to define this region. 



Frame Counter: displays the frame number of the current frame. 



return to the previous slide



go to the next slide 



exit the Slide Show and start MyFlix



Using the Shot Tool
The Shot Tool can quickly summarize your movie for you by representing it as a series of still frames 
corresponding to the individual shots that make up the movie. Shot Tool analyzes the movie for you using 
the latest technology for detecting the abrupt changes between shots.

· To automatically generate a Shot Index you must first load the target movie. Then move to the Shot 
Tool menu and select the “Find cuts” option from the “Generate shot index” sub-menu.

· A progress bar will track the cut detector as it works through the movie looking for those special 
frames that mark the transitions between adjacent shots. When it has finished, these frames are 
displayed as thumbnails in the Shot Index Strip. 

 

You can slide the Shot Index Strip back and forth to browse the thumbnails.

To view a particular thumbnail at full resolution, simply click on the thumbnail of interest and it will appear 
in the Display Panel. The corresponding frame number will become the current frame number in the 
frame number display.

Creating a Shot Index for a movie makes it dramatically easier to keep track of what’s in a particular 
movie. You can go straight to the Shots that you want to play, review and ultimately combine with shots 
from other movies to create your own masterpiece using the MyFlix Editor.

You can modify the Shot Index directly yourself by first selecting a thumbnail and then:

· removing thumbnails that you don’t want and

· adding thumbnails that you want to insert.

Once you have got a representative series of thumbnails you can save a Shot Index and load it    again in 
another session. You will find these options under the Shot Tool menu.

(Note that the companion product WebFlix Pro can also detect shots in movies that use dissolves 
instead of cuts to gently transition from one shot to the next)





Browsing Thumbnails
To browse the thumbnails first move the mouse cursor so it points to the sprocket holes at either the top 
or the bottom of the Shot Index Strip, 

 
and then either
for fine control: drag the thumbnails from side to side through the viewing area with the left mouse 
button, or
for coarse control: click the right mouse button -

· near the left side of the Shot Index Strip to jump close to the beginning of the Shot Index Strip

· near the middle of the Shot Index Strip to jump close to the middle of the Shot Index Strip

· near the right side of the Shot Index Strip to jump close to the end of the Shot Index Strip

For example if you have generated 100 thumbnails and you right click the sprocket holes 
approximately in the middle of the visible region, the strip will reposition to approximately the 50th 
thumbnail. Clicking at the one quarter mark will move you approximately to the 25th thumbnail, the 
three-quarter mark to the 75th thumbnail.



Selecting Clips

The MyFlix Clip Control interface features two film strips – the Focus Strip at the front and the Master 
Strip at the back. The Master Strip always represents the full movie and the Focus Strip allows you to 
define a sub-region or Clip that you can select to be the current the focus of attention. The Player 
Controls operate on the Clip in the Focus Strip. 

0 When you first load a movie or following a Reset, the Clip in the Focus Strip defaults to the entire 
movie – the Master Strip and Focus Strip both contain the full movie. 

1 To explore a particular part of a long movie, it is convenient to define a Clip. There are two basic 
methods: 

· Dragging the mouse on the Master Strip and 

· Entering the frame numbers for the Clip Start and Clip End.

There are variants of these methods that can be very useful:

· Moving the Clip Position and

· Adjusting the Clip Start and Clip End.

The Shot Index can also help you to define Clips. After using the Shot Tool to build a Shot Index, simply 
click any thumbnail to instantly jump to that frame which you can then use as a Clip Start or Clip End 
frame. 

After defining a Clip the player will be positioned at the first frame of the Clip. The position of the Clip 
within the movie is indicated by the orange section in the Master Strip.



Dragging the mouse on the Master Strip:    left click the mouse on the Master Strip and then holding down the 
left mouse button, drag the mouse left or right to define a region (the Clip) on the Master Strip. 

As you drag the mouse you will see the Clip Start and Clip End frame numbers changing.



Moving the Clip Position:  if you have already defined a Clip of 100 frames but you want to look at 
another part of the movie keeping 100 frames in the Clip at any one time, you can drag the orange 
section along the Master Strip by pressing the Ctrl key simultaneously with left mouse clicking the orange 
section and dragging.



Adjusting the Clip Start and Clip End: if you have already defined a Clip but you want to fine tune the 
Clip Start or Clip End with the mouse but without starting again: you can drag either end of the orange 
section along the Master Strip by pressing the Shift key simultaneously with left mouse clicking either end 
of the orange section and dragging.



Entering the frame numbers for the Clip Start and Clip End:    use the VCR Player Controls to position the 
movie where you would like the Clip to start – then click the Select Clip Start button to make the current frame 
number the Clip Start. Repeat the process for the Clip End. (TIP: when you are selecting Clips for editing you can use
the Player Controls to single-step frame at a time to find exactly the frame you want)



Clip: a sequence within a movie that you consider to be of interest. 



Starting the Editor
The Editor allows you to be creative with your video content.

To start the editor, you must have a movie loaded. Then use the Edit menu to create a new Edit List. A 
new panel will open as shown: 

 
You may well want to detach the Display Panel and reorganize your desktop at this point if the Editor 
Panel extends off the bottom of your screen.
You can now create new MPEG-1 movies, either using:

· Single Source Editing (selecting and copying one or more shots from a single movie), or

· Multiple Source Editing (selecting and copying shots from multiple source movies).



Single Source Editing
Before you can start editing you must have already 

· loaded the source movie and 

· started the Editor

You generate your new movie from a list of Clips that you specify:

· select a clip you want to copy from the source movie

· place the Clip into the Edit List using the Editing Controls

· repeat the two steps above for all your Clips
· generate the new movie

In this example we have selected three clips from the source movie ACT.mpg and inserted them into the 
Edit List. We then click on Generate output to create a the new movie with 4353 frames.

Note that you can add Clips in any order – the new Clip is always inserted before the selected Edit List 
line.



 



Multiple Source Editing
Multiple Source Editing combines Clips from more than one source movie.

Proceed as you would for Single Source Editing. When you select your Clips you can load different 
source movies.

In this example we have just inserted a Clip from a movie popov.mpg into an edit list already containing 
three Clips from ACT.mpg.



 



GOP or Frame Accurate?
In MPEG-1 movies, frames are grouped together in a GOP or Group Of Pictures. GOPs are fundamental 
units in MPEG streams and their effect on the editing process should be understood.

 MyFlix supports both GOP accurate and Frame accurate editing.

If you choose an edit point that happens to coincide with a GOP boundary, then Frame and GOP accurate
editing are the same. If however, as is more often the case, you choose an arbitrary point in the movie 
then you need to choose between GOP and Frame accurate editing as it will have an impact on the 
quality of your generated movie at the editing points:

· GOP accurate editing means that MyFlix will move the edit point to a GOP boundary rather than 
the exact frame chosen by the user. The advantage is that higher quality can be achieved in the 
generated movie without an increase in the bit rate. However this may result in frames being included 
in the output which you don’t want.

· Frame accurate editing means that the clips you select will start exactly at the frame number you 
specify, but at the possible cost of some image quality and a small increase in the file size. This is due
the extra decoding and re-encoding of the frames required to construct a legal GOP. 

The switch for Frame or GOP accurate editing is accessed through the Edit menu.





 



 



File Menu
Load Movie: 

Loads a new MPEG movie file. 
Next time you load a movie in the current session, the file loader returns you to the same folder. 

Save Snapshot (JPEG): 
Saves the current frame as a JPEG file. 

Save Snapshot (TIFF): 
Saves the current frame as a TIFF file. 

Quit: 
Exits from the current session of    MyFlix.



View Menu
View Size +: 

Doubles the display size. 

View Size reset: 
Set display size to original. 

View Size -: 
Halves the display size. 

View Attach/Detach +: 
Toggles between detaching and attaching the movie display. 



Shot Tool Menu
New Shot Index

Clear the current Shot Index and start a new one.

Open Shot Index
Load a Shot Index from a file.

Save Shot Index
Save the current Shot Index to file.

Generate Shot Index
Generate an index of all shot boundaries in the current movie.

Modify Shot Index
Manually add and subtract entries from the Shot Index.



Edit Menu
New edit list

Clear the current edit list and start a new one.

Open edit list
Read an edit list from file.

Save edit list
Save an edit list to file.

Close
Close editor.

Frame accurate
Cut at the exact frames specified.

GOP accurate
Use more appropriate points near the specified frames to facilitate smooth cutting.



 Help Menu

Quick help
Clear the current edit list and start a new one.

Release notes
View the release notes for this version of    MyFlix.

About
Show program version.



Register Menu
Test-Drive

How to obtain an evaluation license.

Register MyFlix
How to purchase a permanent license.




